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1 Overview

100GBASE-CR4 Automated Testing—At a Glance

The Keysight D90T0BJCC 100GBASE-CR4 Test Application is an Ethernet test solution that covers
the electrical timing parameters for T00GBASE-CR4 specification (IEEE 802.3bj D3p0).
The Keysight DS010BJCC T00GBASE-CR4 Test Application:

Lets you select individual or multiple tests to run.

Lets you identify the device being tested and its configuration.

Shows you how to make oscilloscope connections to the device under test.

Automatically checks for proper oscilloscope configuration.

Automatically sets up the oscilloscope for each test.

Provides detailed information for each test that has been run and lets you specify the thresholds
at which marginal or critical warnings appear.

Creates a printable HTML report of the tests that have been run.
The tests performed by the Keysight D9010BJCC 100GBASE-CR4 Test Application are intended to

provide a quick check of the electrical health of the DUT. This testing is not a replacement for an
exhaustive test validation plan.
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Overview

Required Equipment and Software

In order to run the TOOGBASE-CR4 automated tests, you need the following equipment and

software:
Hardware
Use one of the following Oscilloscope models. Refer to www.keysight.com for the respective
pandwidth ranges.
Keysight Z-Series Oscilloscopes
Keysight UXR Oscilloscopes
For differential probing (minimum 25GHz)
These can be used as an option, but will be BW limited. Instead, it is
recommended to test with cables on the Real Edge channels.
N2802A 25 GHz InfiniiMax Ill Series probe amplifier
N2803A 30 GHz InfiniiMax Ill Series probe amplifier
N2836A InfiniiMax Ill 26 GHz solder-in probe head
For single-ended probing
SMA cables that are able to support the 25 Gb speed
Keyboard, gty = 1, (provided with the Keysight Infiniium oscilloscope)
Mouse, gty = 1, (provided with the Keysight Infiniium oscilloscope)
Keysight also recommends using a second monitor to view the test application.
Software

The minimum version of Infiniilum Oscilloscope Software (see the Keysight D9010BJCC
100GBASE-CR4 Test Application Release Notes)

Keysight D90TOBJCC 100GBASE-CR4 Test Application software

Licensing information

Refer to the Data Sheet pertaining to T00GBASE-CR4 Test Application to know about the licenses
you must install along with other optional licenses. Visit
“http://www.keysight.com/find/D90T0BJCC” and in the web page's Document Library tab, you may
view the associated Data Sheet.

To procure a license, you require the Host ID information that is displayed in the Keysight License
Manager application installed on the same machine where you wish to install the license.

The licensing format for Keysight License Manager 6 differs from its predecessors. See “Installing the
License Key" on page 13 to see the difference in installing a license key using either of the
applications on your machine.

Keysight D90T0BJCC T00GBASE-CR4 Test Application Methods of Implementation 9
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2 Installing the Test Application
and Licenses

Installing the Test Application 12
Installing the License Key 13

If you purchased the D9010BJCC 100GBASE-CR4 Test Application separate from your Infiniium
oscilloscope, you must install the software and license key.
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Installing the Test Application and Licenses

Installing the Test Application

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the D90T0BJCC
release notes). To ensure that you have the minimum version, select Help > About Infiniium... from

the main menu.

2 To obtain the TOOGBASE-CR4 Test Application, go to Keysight website:
“http://www.keysight.com/find/D9010BJCC”.

3 In the web page's Trials & Licenses tab, click the Details and Download button to view instructions
for downloading and installing the application software.
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Installing the License Key

Installing the Test Application and Licenses 2

To procure a license, you require the Host ID information that is displayed in the Keysight License
Manager application installed on the same machine where you wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:
1 Launch Keysight License Manager on your machine, where you wish to run the Test Application

and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x indicates numeric

values.

ﬂ Keysight License Manager
’ @ Licenses on I (localhost) C
n Ly
§ Full computer name: I Msr.is.keysight.com
8 [Host ID: PCSERNO, JBXXXXXXXX]
=]
=l
w

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 application,
1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

2?2 - ox | |

Why do I need these tools?

‘ Install License File... S ctri+I |
Install License from Text... Ctrl+T
View License Alerts Ctrl+L

Explore Transport URLs
About Keysight License Manager

Figure 2

Configuration menu options to install licenses on Keysight License Manager 5

For more information regarding installation of procured licenses on Keysight License Manager 5,
refer to Keysight License Manager 5 Supporting Documentation.

Keysight D90T0BJCC T00GBASE-CR4 Test Application Methods of Implementation
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Installing the Test Application and Licenses

Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:
1 Launch Keysight License Manager 6 on your machine, where you wish to run the Test Application
and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in Figure 3) that
appears in the Environment tab of the application. Note that x indicates numeric values.

u Keysight License Manager 6

Home Licensing Version ght License Manager
Copyright ight Technolo

Environment
AGILE

MARC Rddress

C:\Program Files Common Files\Int hared Librarie: disthintelé

Figure 3 Viewing the Host ID information in Keysight License Manager 6
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Installing the Test Application and Licenses 2

To install one of the procured licenses using Keysight License Manager 6 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.
2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

m Keysight License Manager 6

Home
Environment
View licenses
License usage

Borrow license

o Specify a remote floating license server

{Administrators can set up a new lice

G Add/remove a license on your local machine

rer here)

Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight License Manager 6,
refer to Keysight License Manager 6 Supporting Documentation.
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2 Installing the Test Application and Licenses
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3  Preparing to Take
Measurements

Calibrating the Oscilloscope 18

Starting the TOOGBASE-CR4 Test Application 19

Configuring TOOGBASE-CR4 Test Application for Test Runs 23
Configuring Switch Matrix 27

Before running the automated tests, you should calibrate the oscilloscope and probe. No test fixture
is required for this application. After the oscilloscope and probe have been calibrated, you are ready
to start the TOOGBASE-CR4 Test Application and perform the measurements.
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3 Preparing to Take Measurements

Calibrating the Oscilloscope

If you have not already calibrated the oscilloscope, refer to the User Guide for the respective
Oscilloscope you are using.

If the ambient temperature changes more than 5 degrees Celsius from the
calibration temperature, internal calibration should be performed again. The
delta between the calibration temperature and the present operating
temperature is shown in the Utilities > Calibration menu.

If you switch cables between channels or other Oscilloscopes, it is necessary to
perform cable and probe calibration again. Keysight recommends that, once
calibration is performed, you label the cables with the channel on which they
were calibrated.
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Preparing to Take Measurements 3

Starting the TOOGBASE-CR4 Test Application

1 Ensure that the TOOGBASE-CR4 Device Under Test (DUT) is operating and set to desired test

modes.
To start the T00GBASE-CR4 Test Application: From the Infiniium Oscilloscope's main menu,
select Analyze > Automated Test Apps > D9010BJCC 100GBASE-CR4 Test App.

Figure b shows the Keysight D9010BJCC T00GBASE-CR4 Test Application window as it appears
when launched within the Infiniium application of the DSO Q-Series Oscilloscope. The Instrument
Setup area in the Set Up tab displays Real Edge, which indicates Channels TR and 3R on the

oscilloscope.

L]

File View Tools Help

Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

Standard Option

© 100GBASE-CR4 [Multi-Lane Option

O single Lane
@ Switch Matrix

Instrument Setup

© Real Edge

Measurement Setup
Select Lane Number

InfiniiSim Setu Set Channel Skew| |Saved Waveform Setu —

Test Report Comments (Optional)

Device Identifier:
Device User Description:

YT You may enter information here to be
. included in the report.

Connect PNA | | Connect ENA |

Il summaries (click for details) Details
2021-05-16 11:07:18:034 PM Connected to The prima * ic

2021-05-16 11:07:21:696 PM Ready v
J

<| [11] »

Unsaved Changes | 0 Tests

Figure 5 T00GBASE-CR4 Test Application main window on a Z-Series Oscilloscope
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Preparing to Take Measurements

Figure 6 shows the Keysight D90T0BJCC 100GBASE-CR4 Test Application window as it appears
when launched within the Infinilum application of the UXR Oscilloscope. The Instrument Setup
area in the Set Up tab displays the corresponding Channel assignments.

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

Standard Option

© 100GBASE-CR4 [Multi-Lane Option
O single Lane

@ Switch Matrix

Instrument Setup
© channels 1 and 2
@ channels 3 and 4

Measurement Setup

Select Lane Number

[InfiniiSim Setup| |Set Channel Skew| [Saved Waveform Setup|

Lane0 |E|

Test Report Comments (Optional)
Device Identifier:
Device User Description:

You may enter information here to be

E included in the report.

Connect PNA | | Connect ENA |

Messages

Summaries (click for details) Details
2019-05-06 12:34:08:765 AM Ready

0 Tests

Figure 6 T00GBASE-CR4 Test Application main window on a UXR Oscilloscope
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Preparing to Take Measurements 3

The task flow pane and the tabs in the main pane show the steps you take in running the automated

tests:

Set Up

Select Tests

Configure

Lets you identify and set up the test environment, including information about the device under
test.

Standard Option Section
It has 100 GBASE-CR4 radio button selected by default, you may select the lane options as
Single Lane or Switch Matrix. When Switch Matrix is selected, the Switch Matrix Setup option
is enabled in the Instrument Setup section.
Instrument Setup Section
In case of Digital Storage Oscilloscopes with real edge channels, the Real Edge option is
selected by default. In case of a UXR Oscilloscope, you may select any one of the two options,
that is, Channel 1 and 2 or Channel 3 and 4. You may click Switch Matrix Setup option to
configure the Switch Matrix for multi-lane testing. Optionally, Switch Matrix can also be
configured from Tools menu > Switch Matrix... option.
Measurement Setup Section
+  InfiniiSim Setup button: This allows to setup InfiniiSim.
Set Channel Skew button: This allows to visually adjust and skew the channels.
Saved Waveform Setup button: This allows to select the saved waveforms on which the
application will run measurement tests.
Select Lane Number button: This option allows to select one of the available lanes for
testing, that is, Lane0, Lane1, Lane2, or Lane3.
Test Report Comments (Optional) Section
This section allows to add device related info which is printed in the final HTML report. It is
quite helpful in easy identification of the specific DUTs in case of multi-DUT testing.
Device Identifier: This field allows to add a unique identifier for your device.
Device User Description: This field allows to provide a description of the DUT.
Comments: This is an additional field which allows a user to add descriptive information
about the DUT or the measurement being carried out.
Connect PNA Button
This option allows to connect to a Performance Network Analyzer through following two modes:
+  Enter/Select VISA address/alias (or SICL address)
This field allows to enter/select the VISA or SICL address of a network instrument in order
to connect to the specific instrument.
Select from Keysight Connection Expert ‘My Instruments’
This field allows to select one of the instruments already connected through Keysight
Connection Expert.

Note: If a “No instrument found.” message is displayed even though the instrument is
visible on the Keysight Connection Expert. Please open the Keysight Connection Expert
application, and select the particular instrument. Then, in the details section of the
instrument, displayed in the right pane, please select the Edit icon to Edit Settings for the
LAN Instrument. Then, please select the Set Protocol option as Socket and click OK.

Connect ENA Button

This option allows to connect to an Economy Network Analyzer through following two modes:
Enter/Select VISA address/alias (or SICL address)
This field allows to enter/select the VISA or SICL address of a network instrument in order
to connect to the specific instrument.
Select from Keysight Connection Expert ‘My Instruments’
This field allows to select one of the instruments already connected through Keysight
Connection Expert.

Note: If a “No instrument found.” message is displayed even though the instrument is
visible on the Keysight Connection Expert. Please open the Keysight Connection Expert
application, and select the particular instrument. Then, in the details section of the
instrument, displayed in the right pane, please select the Edit icon to Edit Settings for the
LAN Instrument. Then, please select the Set Protocol options as Instrument (VXI-11) and
HiSlip, then click OK.

Lets you select the tests you want to run. The tests are organized hierarchically so you can select all

tests in a group. After tests are run, status indicators show which tests have passed, failed, or not

been run, and there are indicators for the test groups.

Lets you configure test parameters (for example, channels used in test, voltage levels, etc.).
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3 Preparing to Take Measurements

Connect Shows you how to connect the oscilloscope to the device under test for the tests that are to be run.

Run Starts the automated tests. If the connections to the device under test need to be changed while
multiple tests are running, the tests pause, show you how to change the connection, and wait for
you to confirm that the connections have been changed before continuing.

Automate Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

In the Configure tab, the values for all such Configuration parameters that are
Oscilloscope-dependent, will correspond to the Oscilloscope Model (DSOs or UXRs), where
you are running the Test Application.
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Preparing to Take Measurements 3

Configuring T0O0GBASE-CR4 Test Application for Test Runs

To run one or more compliance tests on the DUT, which is connected to Oscilloscope, proceed to
configure the TOOGBASE-CR4 Test Application:

1 Inthe SetUp tab (shown in Figure 5 and Figure 6), select a Multi-Lane Option to determine the lane
where the tests must be performed for the T00GBASE-CR4 standard.

If Switch Matrix is selected in the Multi-Lane Option, click Switch Matrix Setup to configure the
Switch Matrix in the Test App. Refer to “Configuring Switch Matrix" on page 27 for more details.
In the Select Tests tab, select one or more tests.

3 In the Configure tab, you may change the values assigned to one or more options to cater to the
compliance requirements for the selected tests. By default, the TOOGBASE-CR4 Test Application
sets optimum values for each configuration parameter.

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests |Configure | Connect | Run | Automate | Results | HTML Report

Mode: O Compliance @ Debug

IEEEB02.3 Tests (Click on a setting to the left)
Signaling Rate (25.78125e9)
Number of UI (1e6)
TX On Voltage Scale (Auto)
TX Off Voltage Scale (Auto)
Disable Pattern Check (Enable)
Save Tested Waveforms (No)
Select waveform Directory (C:\Temp\KRwfm)

FUNODIANOD

Messages

Summaries (click for details) Details
2019-05-06 12:36:42:753 AM Exit? th

0 Tests

Figure 7 Configure tab in the T00GBASE-CR4 Test Application

4 In the Connect tab, view the instructions along with the connection digram to ensure that all
requirements for the physical setup of the testing instruments and the DUT are met. Click
Connection Completed to indicate to the Test Application that the required hardware setup is
complete. The connection diagram for most of the tests matches the one shown in Figure 5 for
DSO-Q Series Oscilloscopes and Figure 6 for UXR Series Oscilloscopes. However, it is a good
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3 Preparing to Take Measurements

practice to verify the connection diagram and instructions displayed under this tab. The Test
Application automatically indicates any changes in connections, if needed, during test runs.

5 Click Run Tests under this tab if you wish to start running tests. However, if you wish to modify the
run settings before performing test runs, switch to the Run tab.

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

Tx Disabled Connection

Please pay attention to the scope connection ~
+ Disable Tx for this test
+ Connect the scope to the DUT Signals as follows:

Channel 1:
Ve+:DUT+
Ve-: GND

Channel 3:

Ve+: DUT-
Ve-: GND

100nf
DC Blocks

TP2 test |2kais
fixture
(HCB) et

n Completed|| | l Suppress All Connection Prompts

Messages
Summaries (click for details) Details
2019-05-07 01:51:39:812 PM HTML Report Refreshed g
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 29 Tests

Figure 8 Connect tab in TOOGBASE-CR4 Test Application on a Q-series DSO

24 Keysight D9010BJCC T00GBASE-CR4 Test Application Methods of Implementation



Preparing to Take Measurements 3

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure [€onnect | Run | Automate | Results | HTML Report -

Tx Disabled Connection

Please pay attention to the scope connection

~

« Disable Tx for this test
+ Connect the scope to the DUT Signals as follows:

Channel 1:
Ve+:DUT+
Ve-: GND

Channel 2:
Ve+: DUT-
Ve-: GND

| Ol”‘.

e ——

TDINNOD
0000 e
® 00 o0 ololololl

TP2

100nf
DC Blocks
TP2 test |2kans
fixture
(H C B) SLn=p=

|Connection Completed|| Suppress All Connection Prompts

Messages

Summaries (click for details) Details
2019-05-06 12:36:42:753 AM Exit? - E it th

Unsaved Changes | 29 Tests

Figure 9 Connect tab in TOOGBASE-CR4 Test Application on a UXR scope
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3 Preparing to Take Measurements

6 Inthe Run tab, you may optionally modify one or more settings as described below, else click Run
to start the test runs:

determine the number of times each test must be run,

automate specific actions in case of events,

store results for certain type of test trials only,

send email notifications if the test runs pause or stop during runs.

¥ 100GBASE-KR4 Application -- 100GBASE-KR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

‘ Pause

Sequencer

Run tests|Once| V¥ |

Event

B Detect events

Store Mode

During run, store details for|Worst| ¥ |trials (up to 25)

Email

B send email when run is paused or stopped

Summary:
- Run tests once
- Store details for up to 25 worst trials (margin)

Messages
Summaries (click for details) Details
2019-05-07 09:25:51:452 AM HTML Report Refreshed
2019-05-07 09:25:54:350 AM Ready

Unsaved Changes | 28 Tests

Figure 10 Run tab in TOOGBASE-CR4 Test Application

7 In the Automate tab, you may optionally configure automation scripts to perform specific
actions/sequences within the Test Application.

8 In the Results tab, which appears automatically after test runs are complete, view the test results
displayed for each selected test.

9 Inthe HTML Report tab, view a comprehensive report for each test within the Application. The Test
Application enables exporting these results in CSV or HTML format for the purpose of analysis.

To perform a high-level analysis on each measurement data, you may upload the results to the
KSB6800A Series Analytics Services Software. Refer to “Uploading Results to Repository" on page 84
to understand an overview on the functionality of this feature.
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Configuring Switch Matrix

Overview

Devices, with TOOGBASE-CR4 standard, can run with the switch matrix using four dual single-ended
connections or without the switch matrix using four differential probe connections. Both options are
fully automated to switch across the four lanes. Switch Matrix requires either the Keysight U3020A
S26 or the BitifEye BIT2100.

This chapter describes the switch matrix feature and steps for configuring the switch matrix in the
Keysight D9010BJCC 100GBASE-CR4 Test Application.

An Oscilloscope has only four Channels to run tests. The limited number of channels may, at times,
limit the testing of some multi-lane standards. Also, it may prove to be a hindrance to run test
procedures for multi-port devices or simultaneous testing of multiple devices. The Switch Matrix
feature on the Infinilum Oscilloscope overcomes such limitations.

The purpose of the ‘Switch Matrix’ feature is to ease the testing procedure, make it more feasible and
to reduce the overall time. Using this feature, you can connect multiple lanes of the source devices to
the correct switches and to obtain an accurate signal path whenever required.

Keysight recommends the following switches to be used with the Test Application:
Keysight U3020A S26
BitifEye BIT-2100

The following figure shows the connection setup for 100GBASE-CR4 tests with the switch matrix.

o o

Precision 3.5 mm

L ¥ BNC to SMA
Lanez‘- Male Adapters
L:E :3‘- 154855-67604)
Lanag+ 50 ohm SMA|
Lane1- Cables
Lane2-
Lane3-
Laned-

T T MNote: Verify Switch and channel

ransmitter connection in Switch Matrix Setup from
under Test the Setup Tab,

Enabling Switch Matrix

Before you begin the testing of multiple lane pairs of the source devices simultaneously, you must
enable the Switch Matrix feature.

To enable the switch matrix feature:
1 Click Tools > Switch Matrix....

Tools Help

Compliance Limits »
Infiniium b
Switch Matrix...

2 In the Configure Switch Matrix Settings dialog box, click On to enable the Switch Matrix feature.
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Configure Switch Matrix Settings*

 Of  On

Enabling the Switch Matrix feature also enables the automated switch control. The option

Automatically select drivers and paths (limited models) in the Configuration Mode section of the Controller
tab is selected by default.

Canfigure Switch Matrix Settings* LEIM

 Of * On

Controller |Signal Paths | Response Comection

Confi ion Mode
' Automatically select drivers and paths (limited models)
" Manually perform these tasks (any supported model)

Establishing Connection to the Switch Drivers

Establishing connection to the Switch Drivers — Automatically

In the Configure Switch Matrix Settings dialog, under the Controller tab:
1 From the Switch Drivers section, select the switch model from the Model: drop-down options.

 Of @ On

Controller

Signal Paths | Response Comection

—Confi ion Mode

¢ Automatically select drivers and paths (limited models)
" Manually perform these tasks (any supported model)

r—Switch Drivers
Model: | BiifEye BIT2100 |

sysight U3020A 526
el I BiiEye BIT2100

The switch settings and the response correction for all paths are reset if you
NOTE .
toggle between switch models.
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2 Click the Connect button to be able to connect the selected switch driver to a physical switch
instrument.

Configure Switch Matrix Settings® =L

" Off & On

Controller

Signal Paths

Response Comection

Configuration Mode

* Automatically select drivers and paths (limited models)
" Manually perform these tasks (any supported model)

Switch Drivers

Model: Bitif Eye BIT2100 =
Connect... ID | Address / Alias | Idertification |
1 <none> <not connected:>

3 A Connect to <switch-model> dialog appears, which gives you two options to establish a
connection to the selected switch models.

4 Select one of the options to establish connection:

Enter/Select VISA address/alias (or SICL address)

1 Select Enter/Select VISA address/alias to type the complete SICL or VISA address of the switch
driver. By default, this option is selected.

Connect to BitifEye BIT2100_1 Switch Driver (BitifEye BIT2100_1) | ?

Currently connected to: <nothing>
Change to
Alias/Address: USBInstrumentl

IDN: <unknown> |§et'|

© Enter/Select VISA address/alias (or SICL address):
USBInstrument1 V)
@ Sclect from Keysight Connection Expert "My Instruments’:

[OK|Cancell
Ready

2 Click the Get button to identify the instrument at the specified address or alias and to view the
current status of the instrument that is connected to the switch driver.

Connect to BitifEye BIT2100_1 Switch Driver (BitifEye BIT2100_1) | ?

Currently connected to: <nothing>
Change to
Alias/Address: USBO0::0x23E0::0x08D2::000024::0::INSTR

IDN: BitifEye,BIT2100,000024,5.4.2-1.20 |G_Et|

© Enter/Select VISA address/alias (or SICL address):

USBO::0x23E0::0x08D2::000024::0::INSTR

@ Sclect from Keysight Connection Expert "My Instruments’:

Ready

3 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected
switch is displayed.
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4

Configure Switch Matrix Settings®

C Of @ On

Controller | Signal Paths | Response Comection

—Configuration Mode

* Automatically select drivers and paths (limited models)
¢~ Manually perform these tasks (any supported model)

—Switch Drivers

Model: | BifEye BIT2100

=

ID | Address / Alims | Identification

1 USBOD:(x23E0:(x08D2::000024::0:INSTR  BitifEye BIT2100,000024.3 .4

| m

—Signal Paths

Connection Guide... |

= Allow InfiniSim for Path Correction

—Connection Change Actions

[ Sleep: ID 3: msec after switches throw

[™ Pause after connection completed (for debug)

oK | Camcel | <«<Fev | Net>» | Reseta. |

Save...

Load...

[

Click OK to save the settings and return to the test environment.
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Select from Keysight Connection Expert ‘My Instruments’

1 Choose Select from Keysight Connection Expert ‘My Instruments’ to control the application with the
help of remote PC. Upon selecting this option, the application starts seeking device information
from the Keysight Connection Expert.

If remote access of the device is enabled, the Connect to <switch-model> dialog box displays the
list of active instruments.

Connect to BitifEye BIT2100_1 Switch Driver (BitifEye BIT2100_1)

Currently connected to: <nothing>
Change to
Alias/Address: TCPIP0::10.116.33.123::inst0::INSTR

IDN:

@ Enter/Select VISA address/alias (or SICL address):

O select from Keysight Connection Expert 'My Instruments’:
B 1dentify / Hide unresponsive addresses
B show SICL Addresses
VISA Alias VISA Address Manufacturer|Model #|Serial #|Software Version
TCPIPD::10.116.33.123::inst0: :INSTR. n/a n/a £ n/a
USBInstrumentl USBO::0x23E0::0x08D2::000024::0::INSTR |nfa n/a nfa n/a
Refresh ox) Cancel

Ready

2 Click to select the Identify / Hide unresponsive addresses check box to run an IDN query to every
instrument in the list and search for the active instruments, if any.

Connect to BitifEye BIT2100_1 Switch Driver (BitifEye BIT2100_1)
Currently connected to: <nothing>

Change to

Alias/Address: TCPIP0::10.116.33.123::inst0: :INSTR

|@| |cancel|

Identifying instruments. Please wait...
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3 Ifany active instruments are found, the Connect to <switch-model> dialog lists out such
instruments. Select the required instrument from the list.

Connect to BitifEye BIT2100_1 Switch Driver (BitifEye BIT2100_1)

Currently connected to: <nothing>
Change to
Alias/Address: USBInstrumentl

IDN: BitifEye,BIT2100,000024,5.4.2-1.20 |G_6t|

@ Enter/Select VISA address/alias (or SICL address):
O select from Keysight Connection Expert 'My Instruments’:

Identify / Hide unresponsive addresses
B show SICL Addresses

VISA Alias VISA Address Manufacturerl\-‘lodel # Sen‘al #Software Version

USBInstrumentl USBO::0x23E0::0x08D2::000024::0: :INSTR. BitifEye BIT2100 000024 3.4.2-1.20
|Refresh||0K|(Cancel|
Ready

4 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected
switch is displayed.

=EE X

Configure Switch Matrix Settings*

" Off & On

Cortroller | Signal Paths | Response Comection

Configuration Mode
* Automatically select drivers and paths (limited models)

" Manually perform these tasks (any supported model)

Switch Drivers

Model: |BitfEye BIT2100 ~|

1D | Address / Alias Idertification

1 USBinstrument1  BitifEye.BIT2100.000024,3.4.2-1.20

5 Click OK in the Configure Switch Matrix Settings dialog to save the settings and return to the test
environment.

The Select from Keysight Connection Expert ‘My Instruments’ option is
available only when the device is powered on and enabled for remote
access.

Establishing connection to the Switch Drivers — Manually

The Manually perform these tasks (any supported model) option allows you to decide how many drivers to
use and how to route the signal paths. It enables the use of any supported switch model.
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In the Configure Switch Matrix Settings dialog:
1 Click to select the Manually perform these tasks (any supported model) radio button in the Configuration
Mode section.

Configure Switch Matrix Settings* EIEIQ
© Of & On
Controller | Signal Paths | Response Comection

Configuration Mode
= Automatically select drivers and paths (limited models)
* Manually perform these tasks (any supported model)

From the Switch Drivers section, select the switch model from the Model: drop-down options.

In the Switch Drivers section, you may use the Add button to append the list of any additional
drivers, which require a connection to an instrument. Use the Delete button to remove a selected
driver from the list. Removing the driver from the list dissociates any signal paths that may have

been assigned to it earlier.

Configure Switch Matrix Settings* E=REEl >

 Off & On

Response Comection

Controller | Signal Paths

—Confi tion Mode
" Automatically select drivers and paths (limited models)
' Manually perform these tasks (any supported model)

r—Switch Drivers

Model: BitifEye BIT2100 -
ID | Address / Mlias | Identification | Add... |

Delete. .. |

—Signal Paths
Lise Signal Paths tab to select switch settings.
™ Aoy 15im for (Reserved for use by application)

—Connection Change Actions

™ Sleep: ID 3: msec after switches throw

[T Pause after connection completed (for debug)

0K | Camcel | <<Prc Next »> Reset Al . Save.. Load...
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4 When you click the Add... button, the Connect... button appears so that you can establish
connectivity to the selected Switch.

Configure Switch Matrix Settings*

" Off & On

Controller

Signal Paths | Response Comection

Configuration Mode
" Mutomatically select drivers and paths (limited models)

¢ Manually perform these tasks (any supported model)

Switch Drivers

Model: | Bitf Eye BIT2100 |

Connect... D | Address / Alias | Identification | Add...
1 <nonex <not connected:
Delete...

Signal Paths
Lizse Signal Paths tab to select switch settings.
I (Reserved for use by application)

Connection Change Actions

[ Sleep: |0 EI msec after switches throw

™ Pause after connection completed (for debug)

ok | cancel | |  Net>> | Resetall. | Save. | load. |

4

%

5 The rest of the steps for establishing a connection to the switch model remains the same as
described in the previous section. The only difference between automatic and manual modes is
that you can add/delete and select switch drivers (any supported model) as per your
requirements and preferences in the manual mode.

Configuring Signal Paths

Once you have enabled the Switch Matrix feature and set up connections to the switch drivers, you
must configure signal paths. The options to configure the signal paths vary depending upon whether
you have selected Automatically select drivers and paths (limited models) or Manually perform these tasks
(any supported model) in the Controller tab of the Configure Switch Matrix Settings dialog.

Refer to the connection diagram before configuring signal paths either for Automatic or Manual
selection. Under the Controller tab, click the Connection Guide button to access the Connection

Diagram dialog.
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Configuring Signal Paths with Automatic Selection

When you have selected Automatically select drivers and paths (limited models) in the Controller tab of the
Configure Switch Matrix Settings dialog:

1

2

Click the Signal Paths tab. The Path Assignment table lists the connection matrix of the device with
the Switch modules.

Scroll down to view the automatic connections that have been established.

At runtime, when the Switch Matrix module is on and when a connection prompt occurs, two events
occur:

The framework suppresses the prompts.

The Switch Matrix module detects the new connection and then throw switches, as indicated in
the Switch column, taking into account the current value of the configuration variable (if any)
associated with the connection.

Configuring Signal Paths with Manual Selection

When you have selected Manually perform these tasks (any supported model) in the Controller tab of the
Configure Switch Matrix Settings dialog:

1
2

10

11

Click the Signal Paths tab in the Configure Switch Matrix Settings dialog.

Select the channel or switch module in one of the drop-down options. Manually select the
alternative channel or driver module from the other drop-down option.

Optionally, you may change the lane assignments and the corresponding Switch modules.

Click the View Connections... button to view the signal path mapping, to understand how the
signal path maps to the connection diagrams being used by the application.

The Signal Paths Connection View dialog is displayed. Select any one of the available options in the
Connection: drop-down.

The Path Assignment & Response Correction area displays the connections configured for the
corresponding connection diagrams in the Connection: drop-down.

Select an entry in the Path Assignment & Response Correction area to view the corresponding test
information.

Click the Tests... button to view information about the tests that use the selected connection to
perform automated tests.

Click the Close button to exit and return to the Configure Switch Matrix Settings dialog to finish the
signal path configuration.

If required, use the Reset Paths... button to clear all switch and response correction settings for all
paths. Click OK if you wish to proceed.

Also, if needed, use the Load Preconfigured Settings... button to set switches for all paths as per the
recommended settings. Click OK if you wish to proceed.
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Response Correction

You must specify the response correction after you finish configuring the signal paths. Configuring
this area is vital as it impacts the measurement accuracy, credibility and performance of the
Oscilloscope. The purpose of response correction is to correct the channel frequency response of the
oscilloscope.

Configure Switch Matrix Settings* = [ x
" Off (& On

Controller

Signal Paths Response Correction

—Selected Path Actions

Choose carrection mode: V] (<ctrl> + e)

} Execute Switches |

Test Point | Driver,Module,Switch_Terminals in-out | Scope | Response Correction |
Lanel+ 1,3,1_1-0 Channel 1
Lanel+ 1,3,1_2-0 Channel 1

oK Cancel << Prev Next Reset All... Save... Load...

For each scope channel that you select, the default response correction method is None, which turns
off normalization for the specified path.

You may use the Edit Settings button or double-click the selected row to access the corresponding
configuration dialog, if you wish to make further changes to a specific scope channel configuration.

Use the Execute Switches button to establish a connection between the selected test point and scope
channel. The color of this button corresponds to the Oscilloscope Channel where the Switch is
connected to.

In the following example, the application displays the prompt indicating that a connection is
established when you click Execute Switches after selecting the first row. Click OK to close the prompt.

100GBASE-CR4 App Test Information

'0 Path is now connected: [TestPoint Lane(+ -> Scope Channel 1]
v
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Once you have finished response corrections for all connections, click OK in the Configure Switch Matrix
Settings dialog. The application redirects you to the test environment.
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application

Methods of Implementation

4 Main Voltage Measurements

Differential Peak to Peak Output Voltage Test with TX Disabled 41
DC Common Mode Output Voltage Test 42

AC Common Mode Output Voltage Test 43

Differential Peak to Peak Output Voltage Test 44

This section provides the Methods of Implementation (MOls) for the T00GBASE-CR4 Main Voltage
Measurements using a Keysight Infiniium oscilloscope and the TO0GBASE-CR4 Test Application.

KEYSIGHT

TECHNOLOGIES
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40

Main Voltage Measurements

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

[ 1EEES02.3 Tests

Main Voltage Measurements (pattern: PRBS9)
Differential Peak to Peak Output Voltage Test with TX disabled
DC Common Mode Output Voltage Test
AC Common Mode Output Voltage Test
Differential Peak to Peak Output Voltage Test

B sJitter and Signaling Rate Measurements (pattern: PRBS9)

B output Waveform Measurements (pattern: PRBS9)

B return Loss PNA/ENA Measurements

B DME/EEE Waveform Measurements

Summaries (click for details) Details
2019-05-07 01:51:39:812 PM HTML Report Refreshed :
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 4 Tests

Figure 11 Tests that appear under Main Voltage Measurements

Limits for Main ~ The limits for tests under main voltage measurements can be found in section 92.8.3.1 of IEEE 802.3

Voltage  specifications. Refer to Table 92-6 for corresponding values.
Measurements . Djfferential Peak to Peak Output Voltage with TX disabled (max 35 mV)
DC Common Mode Output Voltage (max 1.9 V)
AC Common Mode Output Voltage (max 30 mV)
Differential Peak to Peak Output Voltage (max 1200 mV)
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Differential Peak to Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak voltage is less than
35 mV.

PASS Condition =~ The max peak-to-peak voltage is less than 35 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is truly with TX disabled (no valid data transitions).
3 Measure peak-to-peak voltage of the signal.

4 Compare the max peak-to-peak voltage to 35 mV.
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DC Common Mode Output Voltage Test

42

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the common mode signal of the differential pair is between
0-1.9V.

This measurement can be done only with dual-single ended connection; it cannot be done with a
differential probing connection.

The signal is between 0-1.9 V.

1 Obtain sample or acquire signal data.
2 Verify that there is a signal and that the connection is dual-single ended.
3 Measure the V5, and Vi, and get the worst result:

If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real
Edge.

If the Test Application is running on the UXR Oscilloscope, perform the measurement with the
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set
to Channels 3 and 4.

4 Compare the voltage measurement to 0-1.9 V.
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AC Common Mode Output Voltage Test

The purpose of this test is to verify that the common mode signal of the differential pair rms voltage
does not exceed 30 mV.

This measurement can be done only with dual-single ended connection; it cannot be done with a
differential probing connection.

PASS Condition  The signal is less than 30 mV.

Measurement 1 Obtain sample or acquire signal data.
Algorithm 5 v/grify that there is a signal and that the connection is dual-single ended.
3 Measure the Vipg:

If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real
Edge.

If the Test Application is running on the UXR Oscilloscope, perform the measurement with the
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set
to Channels 3 and 4.

4 Compare the voltage measurement to 30 mV.
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Differential Peak to Peak Output Voltage Test

44

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a
PRBS9 pattern is less than 1200 mV.

The differential signal max peak to peak voltage on a PRBS9 pattern is less than 1200 mV.
1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 1200 mV.
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o Jitter and Signaling Rate
Measurements

Signaling Rate 47
Jitter (Even-0dd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated Jitter) 48

This section provides the Methods of Implementation (MOls) for the Jitter and Data Rate
Measurements using a Keysight Infiniium oscilloscope and the TOOGBASE-CR4 Test Application.

KEYSIGHT

TECHNOLOGIES



5 Jitter and Signaling Rate Measurements

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

[ 1EEES02.3 Tests

B Main Voltage Measurements (pattern: PRBS9)

Jitter and Signaling Rate Measurements (pattern: PRBS9)
Signaling Rate
Even-Odd Jitter
Bounded Uncorrelated Jitter
Total Uncorrelated Jitter

B output waveform Measurements (pattern: PRBS9)

. Return Loss PNA/ENA Measurements

B DME/EEE Waveform Measurements

S1S31 1D5313S

Messages
Summaries (click for details)
2019-05-07 01:51:39:812 PM HTML Report Refreshed
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 4 Tests

Figure 12 Tests that appear under Jitter and Signaling Rate Measurements
Limits for Jitterand ~ The limits for tests under jitter and signaling rate measurements can be found in various sections of
Signaling Rate  IEEE 802.3 specification. Refer to Table 92-6 for corresponding values.
Measurements . Signaling Rate (25.78125 +100 ppm GBd) (section 92.8.3.9)
Even-0dd Jitter (max 35 mUI) (section 92.8.3.8.1)
Bounded Uncorrelated Jitter (max 100 mUl) (section 92.8.3.8.2)
Total Uncorrelated Jitter (max 180 mUI) (section 92.8.3.8.2)
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Signaling Rate

The purpose of this test is to verify that the signaling rate mean is between 25.78125 +100 ppm GBd.
PASS Condition =~ The mean signaling rate is between 25.78125 +100 ppm GBd.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).
3 Set memory depth to capture the number or Ul set in the configuration tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean signaling rate.

6 Report min and max values.

7

Compare and report the mean signaling rate value to 25.78125 +100 ppm GBd.
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Jitter and Signaling Rate Measurements

Jitter (Even-0dd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated Jitter)

48

PASS Conditions

Measurement
Algorithm

The purpose of this test is to verify that differential signal's Even-0dd Jitter is less that 35 mUI,
Bounded Uncorrelated Jitter is less than 100 mUI, and Total Uncorrelated Jitter is less than 180 mUI.
If all tests are selected, all tests are run on a single measurement. Each test can be run individually
by selecting any or some of the tests.

Even-0Odd Jitter is less than 35 mUI.
Bounded Uncorrelated Jitter is less than 100 mUI.
Total Uncorrelated Jitter rms is less than 180 mUl.

Obtain sample or acquire signal data.

1

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).
3 Set memory depth to capture the number or Ul set in the configuration tab.
4

Set clock recovery to OJTF First Order PLL with Nominal Data Rate 25.78125 Gb/s and Loop
Bandwidth to 10 MHz.

Using EZJIT, measure Even-0dd Jitter, BUJ, and TUJ at BER of TOE-12.
6 Compare and report the values to their respective maximum specification.
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6 Output Waveform
Measurements

Steady State Voltage Vf 51
Linear Fit Pulse Peak 52
Signal-to-Noise-and-Distortion Ratio 53

This section provides the Methods of Implementation (MOIs) for the Transmitter Output Waveform
Measurements for Transition Time using a Keysight Infiniilum oscilloscope and the TOOGBASE-CR4

Test Application.
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6 Output Waveform Measurements

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

[ 1EEE802.3 Tests
B Main Voltage Measurements (pattern: PRBS9)
B sitter and Signaling Rate Measurements (pattern: PRBS9)
O output Waveform Measurements (pattern: PRBS9)
Steady-State Woltage Vf
Linear Fit Pulse Peak
Signal-to-noise-and-distortion ratio
Normalized Coefficient Step Size
Full Scale Range Tests
eturn Loss PNA/ENA Measurements
YME/EEE Waveform Measurements

S1S31 1D5313S

Messages

Summaries (click for details) Details
2019-05-07 01:51:39:812 PM HTML Report Refreshed
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 3 Tests

Figure 13 Tests that appear under Output Waveform Measurements
Limits for Qutput ~ The limits for some tests under output waveform measurements can be found in various sections of
Waveform  |EEE 802.3 specification. Refer to Table 92-6 for corresponding values.
Measurements . Steady State Voltage Vf (340-600 mV) (section 92.8.3.5.2)
Linear Fit Pulse Peak (0.45 * Vf) (section 92.8.3.5.2)
Signal-to-noise-and-distortion ratio (26 dB) (section 92.8.3.7)
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Steady State Voltage Vf

The purpose of this test is to verify that the Steady State Voltage as described in section 85.8.3.3 is
between 0.34 and 0.6 V.

PASS Condition ~ The Steady State Voltage is between 0.34 and 0.6 V.

Measurement 1 Set memory depth to capture one full PRBSS pattern and scale.

Algorithm 5 cq(culate Vf using the equations in section 85.8.3.3.5. The result value is the sum of the columns
in P1 (Eq. 85-9).

3 Compare and report the result to 0.34-0.6 V.
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Linear Fit Pulse Peak

PASS Condition

Measurement
Algorithm

52

The purpose of this test is to verify that the Linear Fit Pulse as described in section 85.8.3.3 is greater
than the Vf * 0.45.

The Linear Fit Pulse is greater than Vf * 0.45.

1 Set memory depth to capture one full PRBS9 pattern and scale.

2 Calculate p(k) linear fit using the equations in section 85.8.3.3.5. The result value is the max of
p(k).
3 Compare and report the result to 0.45*%Vf.
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Output Waveform Measurements 6

Signal-to-Noise-and-Distortion Ratio

The purpose of this test is to verify that the Signal-to-noise-and-distortion ratio (SNDR) is greater
than 26dB.

PASS Condition =~ The SNDR must be greater than 26dB.

Measurement 1 Calculate SNDR using measurements from Level RMS - PRBS pattern test and error from Linear
Algorithm Fit Pulse Peak test.

2 Compare and report the value of SNDR with 26 dB.
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6 Output Waveform Measurements
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application

Methods of Implementation

/- Normalized Coefficient Step
Size Measurements

inc c(0)hold c(-T)hold 57
dec c(O)hold c(-T)hold 58
hold c(Q)inc c(-1)hold 59
hold c(0)dec c(-1)hold 60
hold c(O)hold c(-1)inc 61

hold c(0)hold c(-1)dec 62

abs Coefficient Step Size ¢
abs Coefficient Step Size ¢
abs Coefficient Step Size ¢
abs Coefficient Step Size ¢
abs Coefficient Step Size ¢

1
1
1
1
1
abs Coefficient Step Size c(1

P
==

This section provides the Methods of Implementation (MOls) for the Transmitter Output Waveform
Normalized Coefficient Step Size Measurements using a Keysight Infiniium oscilloscope and the
100GBASE-CR4 Test Application.

KEYSIGHT

TECHNOLOGIES



7 Normalized Coefficient Step Size Measurements

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

O 1EEE802.3 Tests
B Main voltage Measurements (pattern: PRBS9)
B jitter and Signaling Rate Measurements (pattern: PRBS9)
[0 output waveform Measurements (pattern: PRBS9)
Steady-State Voltage Vf
Linear Fit Pulse Peak
Signal-to-noise-and-distortion ratio
Normalized Coefficient Step Size
abs Coefficient Step Size c(1)inc c(0)hold c(-1)hold
abs Coefficient Step Size c(1)dec c{0)hold c(-1)hold
abs Coefficient Step Size c(1)hold c(0)inc c{-1)hold
abs Coefficient Step Size c(1)hold c(0)dec c(-1)hold
abs Coefficient Step Size c(1)hold c(0)hold c(-1)inc
abs Coefficient Step Size c(1)hold c(0)hold c(-1)dec
B rull Scale Range Tests
B Return Loss PNA/ENA Measurements
B DME/EEE Waveform Measurements

SEEn
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Messages
Summaries (click for details) Details
2019-05-07 01:51:39:741 PM Refreshing HTML Report
2019-05-07 01:51:39:812 PM HTML Report Refreshed
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 6 Tests

Figure 14 Tests that appear under Normalized Coefficient Step Size

Limits for Normalized ~ The limits for tests under normalized coefficient step size measurements can be found in various
Coefficient Step Size  sections of IEEE 802.3 specification. Refer to Table 92-6 for corresponding values.
Measurements . 5 coefficient step size (min. 0.0083) (section 92.8.3.5.4)

abs coefficient step size (max. 0.05) (section 92.8.3.5.4)
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size ¢(1)inc c¢(0)hold c(-1)hold

The purpose of this test is to verify that the difference amplitude between coefficient updates falls
between the specified values 0.0083 and 0.05.

PASS Condition  The difference in the coefficient update when c(1) is incremented to the previous is within 0.0083 to

0.05.
Measurement Request transmitter to be set to 'PRESET' condition.
Algorithm Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.
Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.

1
2
3
4
5 Request to change the Tx setting to a Baseline condition that allows for increment.
6 Calculate the equalized coefficients using equation (85-13).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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7

Normalized Coefficient Step Size Measurements

abs Coefficient Step Size ¢(1)dec c(0)hold c(-1)hold

58

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the coefficient updates,
falls between the specified values of -0.0083 to -0.05.

The difference in the coefficient update when c(1) is decremented to the previous is within -0.0083 to
-0.05.

1
2
3
4
5
6
7
8

9

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.

Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.
Request to change the Tx setting to a Baseline condition that allows for decrement.
Calculate the equalized coefficients using equation (85-13).

Request to change the Tx setting to decrement.

Calculate linear fit pulse response.

Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many decrements to be tested.
12 Compare and report the values and verify they are in the range of -0.05 to -0.0083.
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size ¢(1)hold c(0)inc c(-1)hold

The purpose of this test is to verify that the difference in amplitude between the coefficient updates
falls between the specified values of 0.0083 to 0.05.

PASS Condition ~ The difference in the coefficient update when c(0) is incremented to the previous state is within

0.0083 to 0.05.
Measurement Request transmitter to be set to 'PRESET' condition.
Algorithm Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.
Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.

1
2
3
4
5 Request to change the Tx setting to a Baseline condition that allows for increment.
6 Calculate the equalized coefficients using equation (85-13).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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Normalized Coefficient Step Size Measurements

abs Coefficient Step Size ¢(1)hold c(0)dec c(-1)hold

60

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the coefficient updates
falls between the specified values of -0.0083 to -0.05.

The difference in the coefficient update when c(0) is decremented to the previous state is within
-0.0083 and -0.05.

1
2
3
4
5
6
7
8

9

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.

Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.
Request to change the Tx setting to a Baseline condition that allows for decrement.
Calculate the equalized coefficients using equation (85-13).

Request to change the Tx setting to decrement.

Calculate linear fit pulse response.

Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many decrements to be tested.
12 Compare and report the values and verify they are in the range of -0.05 to -0.0083.
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Normalized Coefficient Step Size Measurements 7

abs Coefficient Step Size ¢(1)hold c(0O)hold c(-1)inc

The purpose of this test is to verify that the difference in amplitude between the coefficient updates
falls between the specified values of 0.0083 to 0.05.

PASS Condition  The difference in the coefficient update when c(-1) is incremented to the previous state is within
0.0083 and 0.05.

Measurement
Algorithm

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.

Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.

1
2
3
4
5 Request to change the Tx setting to a Baseline condition that allows for increment.
6 Calculate the equalized coefficients using equation (85-13).

7 Request to change the Tx setting to increment.

8 Calculate linear fit pulse response.

9 Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many increments to be tested.

12 Compare and report the values and verify they are in the range of 0.0083 to 0.05.
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Normalized Coefficient Step Size Measurements

abs Coefficient Step Size ¢(1)hold c(0)hold c(-1)dec

62

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the difference in amplitude between the coefficient updates
falls between the specified values of -0.0083 to -0.05.

The difference in the coefficient update when c(-1) is decremented to the previous state is within
-0.0083 and -0.05.

1
2
3
4
5
6
7
8

9

Request transmitter to be set to 'PRESET' condition.

Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition.

Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3.
Request to change the Tx setting to a Baseline condition that allows for decrement.
Calculate the equalized coefficients using equation (85-13).

Request to change the Tx setting to decrement.

Calculate linear fit pulse response.

Calculate the equalized coefficients using equation (85-13).

10 Compare result to previous setting.

11 Loop steps 7-10 for as many decrements to be tested.
12 Compare and report the values and verify they are in the range of -0.05 to -0.0083.
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application
Methods of Implementation

8  Full Scale Range Tests

Minimum Pre-cursor Full-scale Ratio 65
Minimum Post-cursor Full-scale Ratio 66

This section provides the Methods of Implementation (MOls) for the Transmitter Output Waveform
Full-Scale Range Measurements using a Keysight Infiniium oscilloscope and the TO0GBASE-CR4

Test Application.

KEYSIGHT

TECHNOLOGIES



Full Scale Range Tests

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

O 1EEE802.3 Tests
B Main Voltage Measurements (pattern: PRBS9)
B Jitter and Signaling Rate Measurements (pattern: PRBS9)
O output waveform Measurements (pattern: PRBS9)
B steady-state Voltage Vi
B Linear Fit Pulse Peak
B Signal-to-noise-and-distortion ratio
B normalized Coefficient Step Size
Full Scale Range Tests
Minimum Pre-cursor Full-scale Ratio
Minimum Post-cursor Full-scale Ratio
B Return Loss PNA/ENA Measurements
B DME/EEE Waveform Measurements

S15§31 123138

Messages

Summaries (click for details) Details
2019-05-07 01:51:39:812 PM HTML Report Refreshed
2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 2 Tests

Figure 15 Tests that appear under Full Scale Range Tests

Limits for Full Scale ~ The limits for tests under full scale range tests can be found in various sections of IEEE 802.3
Range Tests  specification. Refer to Table 92-6 for corresponding values.
minimum precursor full-scale ratio (1.54) (section 92.8.3.5.5)

minimum precursor full-scale ratio (4) (section 92.8.3.5.5)
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Full Scale Range Tests 8

Minimum Pre-cursor Full-scale Ratio

The purpose of this test is to verify that the minimum Pre-cursor is greater than or equal 1.54.

PASS Condition ~ When the coefficients are set to c(1) zero ¢(0) minimum and c(-1) minimum, the pre-cursor full-scale
ratio is greater than or equal 1.54.

Measurement 1
Algorithm

©O© 00 N O O

Request transmitter to be set to 'PRESET' condition (only if not previously have 'PRESET'
measurement on same trial from step size).

Set memory depth to capture one full PRBS9 pattern and scale.

Calculate linear fit pulse response at 'PRESET' condition (if not previously done in same trial on
step size).

Define matrix Rm using Equation (92-4) and w using equation (85-2) from IEEE 802.3 (if not
previously done in same trial on step size).

Request to change the Tx setting to c(-1) zero and c¢(0) and c(1) to their minimum values.
Calculate linear fit pulse response.

Calculate equalized coefficients using equation (85-13).

Calculate precursor ratio [c(0)-c(-1))/[c(0)+c(-1)].

Report and compare the value calculated in step 8 with 1.54.
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Full Scale Range Tests

Minimum Post-cursor Full-scale Ratio

66

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the minimum Post-cursor is greater than or equal to 4.

When the coefficients are set to ¢(1) minimum ¢(0) minimum and c(-1) zero, the post-cursor
full-scale ration is greater than or equal to 4.

1 Request transmitter to be set to 'PRESET' condition (only if not previously have 'PRESET'
measurement on same trial from step size).
Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at 'PRESET' condition (if not previously done in same trial on
step size).

4 Define matrix Rm using Equation (92-4) and w using equation (85-2)from IEEE 802.3 (if not
previously done in same trial on step size).

Request to change the Tx setting to c(1) zero and c(0) and c(-1) to their minimum values.
Calculate linear fit pulse response.

Calculate equalized coefficients using equation (85-13).

Calculate precursor ratio [c(0) - c(1))/[c(0) + c(1)].

Report and compare the value calculated in the previous step with 4.

©O© 00 N O O
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application
Methods of Implementation

Coefficient Initialization
Measurements

Coefficient Initialization (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1)) 69
Coefficient Initialization (c(0)-c(1)+c(-1 1

This section provides the Methods of Implementation (MOIs) for the Transmitter Output Waveform
Coefficient Initialization Measurements using a Keysight Infiniium oscilloscope and the
T00GBASE-CR4 Test Application.

KEYSIGHT

TECHNOLOGIES



9

Coefficient Initialization Measurements

¥ 100GBASE-CR4 Application - 100GBASE-CR4 App Device 1

File View Tools Help
Set Up |Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

[ 1EEES02.3 Tests
B Main voltage Measurements (pattern: PRBS9)
B Differential Peak to Peak Output Voltage Test with TX disabled
B pc common Mode Output Voltage Test
B Ac common Mode Output Voltage Test
B Differential Peak to Peak Output Voltage Test
B Jitter and Signaling Rate Measurements (pattern: PRBS9)
B signaling Rate
. Even-0dd Jitter
B Bounded Uncorrelated Jitter
B 1otal Uncorrelated Jitter
(| Output Waveform Measurements (pattern: PRBS9)
B steady-State Voltage VF
Linear Fit Pulse Peak
Signal-to-noise-and-distortion ratio
Normalized Coefficient Step Size
Full Scale Range Tests
Coefficient Initialization Tests
Coefficient Initialization (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1))
Coefficient Initialization (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1))
B Return Loss PNA/ENA Measurements
B DME/EEE Waveform Measurements
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Figure 16 Tests that appear under Normalized Coefficient Step Size

Limits for Coefficient ~ The limits for tests under coefficient initialization measurements can be found in section 92.8.3.5.3 of
Initialization ~ |EEE 802.3-2018 specification.

Measurements . Coefficient Initialization (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1))
(min. 1.167000 and max.1.419000) (section 92.8.3.5.3)

Coefficient Initialization (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1))
(min.2.313000 and max. 2.827000) (section 92.8.3.5.3)
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Coefficient Initialization Measurements 9

Coefficient Initialization (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1))

The purpose of this test is to verify that during the PMD (Physical Medium Dependent Sublayer)
initialization phase the coefficients of the transmitter equalizer are configured in such a way that the
coefficient initialization ratio (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1)) falls between the specified values.

PASS Condition  The ratio (c(0)+c(1)-c(-1))/(c(0)+c(1)+c(-1)) for coefficients on an initialized signal should fall between
1.161000 and 1.413000.

Measurement 1 Request transmitter to be set to 'PRESET' condition (only if there is no existing 'PRESET'
Algorithm measurement on same trial from step size or full scale range tests).

Request transmitter to be set to initialize condition.

Verify that a signal is connected and has PRBS9 pattern.

Capture the 511 bits of the PRBS9 pattern.

Calculate the coefficients defined in equation (92-5).

Calculate the coefficient initialization (c(0)+c(1)-c(-1)/(c(0)+c(1)+c(-1)) based on the results.

Report the result, and verify whether the result is in the range 1.161000 to 1.419000 or not.

~N O o AWwN
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Coefficient Initialization Measurements

Coefficient Initialization (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1))

70

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that during the PMD (Physical Medium Dependent Sublayer)
initialization phase the coefficients of the transmitter equalizer are configured in such a way that the
coefficient initialization ratio (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1)) falls between the specified values.

The ratio (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1)) for coefficients on an initialized signal should fall between
2.313000 and 2.827000.

1

~N O o AWwN

Request transmitter to be set to 'PRESET' condition (only if there is no existing 'PRESET'
measurement on same trial from step size or full scale range tests).

Request transmitter to be set to initialize condition.

Verify that a signal is connected and has PRBS9 pattern.

Capture the 511 bits of the PRBS9 pattern.

Calculate the coefficients defined in equation (92-5).

Calculate the coefficient initialization (c(0)-c(1)+c(-1))/(c(0)+c(1)+c(-1)) based on the results.
Report the result, and verify whether the result is in the range 2.313000 and 2.827000 or not.
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KEYSIGHT
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application
Methods of Implementation

Return Loss PNA/ENA
Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss Measurements using
a Keysight Infiniium oscilloscope, PNA or ENA, and the T00GBASE-CR4 Test Application. The test
application controls the PNA/ENA to set the test limits and run the test. Please ensure that the
PNA/ENA are calibrated prior to running a measurement.

To prevent blank graphs / empty measurement screen-shots being displayed after test run in the
HTML Report, it is recommended to use VNC for remotely controlling the PNA/ENA.

PNA - Performance Network Analyzer
ENA - Economy Network Analyzer



10 Return loss PNA/ENA Measurements

Limits for Return Loss
PNA/ENA
measurements

Measurement
Algorithm (common
for all three tests)

72

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

[ 1EEES02.3 Tests
B Main Voltage Measurements (pattemn: PRBS9)
B Jitter and Signaling Rate Measurements (pattern: PRBS9)
B output waveform Measurements (pattern: PRBS9)
Return Loss PNA/ENA Measurements
Differential Output Return Loss
Common-mode to Common-mode Output Return Loss
Common-mode to Differential Output Return Loss
. DME/EEE Waveform Measurements
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2019-05-07 01:51:43:015 PM Ready

Unsaved Changes | 3 Tests

Figure 17 Tests that appear under Return loss PNA/ENA Measurements
The limits for tests under return loss PNA/ENA measurements can be found in various sections of
IEEE 802.3 specification. Refer to Table 92-6 for corresponding values.

Differential Output Return Loss (refer to section 92.8.3.2 and see Eqg. 92-1)

Common-mode to Common-mode Output Return Loss (refer to section 92.8.3.4 and see Eq.
92-3)

Common-mode to differential mode Output Return Loss (refer to section 92.8.3.3 and see Eqg.
92-2)
Ensure that the PNA/ENA is physically connected and calibrated.

2 Inthe Set Up tab of the Test Application, click Connect PNA or Connect ENA to establish connectivity
to the connected equipment.

3 Click the Select Tests tab and check the tests to measure the Return Loss Measurements.
Click Run under the Run tab. The Test Application automatically calculates the return loss.
5 Compare the reported values with the specification to check for compliance.
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Keysight D90T10BJCC TO0GBASE-CR4 Test Application

Methods of Implementation

DME/EEE Waveform
Measurements

DME Differential Peak-to-Peak Output Voltage Test 75

DME T1-Transition Position Spacing (period) Test 76

DME T2-Clock Transition to Clock Transition Test 77

DME T3-Clock Transition to Data Transition Test 78

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled 79
EEE Differential Peak-to-Peak Output Voltage Test 80

EEE Common Made Deviation Voltage Test 81

This section provides the Methods of Implementation (MOls) for the DME and EEE Waveform
Measurements using a Keysight Infiniium oscilloscope and the TOOGBASE-CR4 Test Application.

KEYSIGHT

TECHNOLOGIES



1 DME/EEE Waveform Measurements

¥ 100GBASE-CR4 Application -- 100GBASE-CR4 App Device 1

File View Tools Help
Set Up | Select Tests | Configure | Connect | Run | Automate | Results | HTML Report

O 1EEE802.3 Tests
B Main Voltage Measurements (pattern: PRBS9)
B Jitter and Signaling Rate Measurements (pattern: PRBS9)
B output Waveform Measurements (pattern: PRBS9)
B return Loss PNA/ENA Measurements
DME/EEE Waveform Measurements
DME Differential Peak to Peak Output Voltage Test
DME T1-Transition Position Spacing (period) Test
DME T2-Clock Transition to Clock Transition Test
DME T3-Clock Transition to Data Transition Test
EEE Differential Peak to Peak Output Voltage Test with TX disabled
EEE Differential Peak to Peak Output Voltage Test
EEE Common Mode Voltage Deviation Test
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Figure 18

Limits for DME/EEE ~ The limits for tests under DME/EEE Waveform measurements can be found in various sections of
Waveform  IEEE 802.3 specification. The T00GBASE-CR4 DME specifications can be found in IEEE
measurements  802.3ap-2012 section 73.5.1 Table 73-1 and section 73.5.3 Table 73-2. The TO0GBASE-CR4 EEE
specifications can be found in section 72.7.1 Table 72-6.

DME Differential Peak-to-Peak Output Voltage (0.6-1.2 V)

DME T1 (8.2 ns-0.01% to 3.2 ns+0.1%)

DME T2 (6.2 ns-6.6 ns)

DME T3 (3.0 ns-3.4 ns)

EEE Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV)
EEE Differential Peak-to-Peak Output Voltage with TX enabled (min 720 mV)
EEE Common Mode Voltage Deviation (150 mV)
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DME/EEE Waveform Measurements 1

DME Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 1010
pattern is less than 1200 mV.

PASS Condition ~ The differential signal max peak-to-peak voltage on a 1010 pattern is less than 1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a 1010 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
4 Compare the min and max peak-to-peak voltage to be within 0.6 to 1.2 V.
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DME/EEE Waveform Measurements

DME T1-Transition Position Spacing (period) Test

76

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that transition spacing of the DME signal is 3.2 ns £0.01%.

The mean period is between 3.2 ns +0.01%.

1
2
3
4
5
6

Obtain sample or acquire signal data.

Verify that there is a signal is connected.

Set memory depth to capture the number or Ul set in the configuration tab.

Request DUT in DME mode.

Measure the unit interval of the differential DME signal - set Ul measurement to SEMI, 3.2e-9.
Compare the mean measurement to 3.2 ns +0.01%.
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DME/EEE Waveform Measurements 1

DME T2-Clock Transition to Clock Transition Test

The purpose of this test is to verify clock to clock transition is 6.2 ns to 6.6 ns.
PASS Condition =~ The mean period is between 6.2 ns to 6.6 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or Ul set in the configuration tab.
4 Request DUT in DME mode.

5 Measure the rising to rising edge.

6

Compare the min and max values to measurement to 6.2 ns to 6.6 ns.
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DME/EEE Waveform Measurements

DME T3-Clock Transition to Data Transition Test

78

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify clock to data transition is 3.0 ns to 3.4 ns.

The min and max Ul time is between 3.0 ns to 3.4 ns.

1
2
3
4
5
6

Obtain sample or acquire signal data.

Verify that there is a signal is connected.

Set memory depth to capture the number or Ul set in the configuration tab.

Request DUT in DME mode.

Measure the unit interval of the differential DME signal - set Ul measurement to SEMI, 3.2e-9.
Compare the min and max values to measurement to 3.0 ns to 3.4 ns.
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DME/EEE Waveform Measurements 1

EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak voltage is less than
30 mV.

PASS Condition =~ The max peak-to-peak voltage is less than 30 mV.

Measurement

Obtain sample or acquire signal data.
Algorithm

1
2 Request DUT to be EEE mode.

3 Check that the signal is truly with TX disabled (no valid data transitions).
4 Measure peak-to-peak voltage of the signal.

5 Compare the max peak-to-peak voltage to 30 mV.
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DME/EEE Waveform Measurements

EEE Differential Peak-to-Peak Output Voltage Test

80

PASS Condition

Measurement
Algorithm

The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 1010
pattern is greater or equal to 720 mV.

The differential signal max peak-to-peak voltage on a 1010 pattern is greater than or equal to
720 mV.

1 Obtain sample or acquire signal data.

2 Request DUT in EEE mode.

3 Verify that there is a signal is connected and has a 1010 pattern.
4

5

Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.
Compare the min voltage to be greater than or equal to 720 mV.
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EEE Common Mode Deviation Voltage Test

The purpose of this test is to verify that the common mode signal of the differential pair of the pre-LPI
signal and the LPI signal is within £150 mV.

PASS Condition ~ The signal voltage change between pre and post LPI is within 150 mV change.

Measurement 1
Algorithm 5

3

4

5

6

7

8

Obtain sample or acquire signal data.

Verify that there is a signal and that the connection is dual-single ended.
Request DUT to be pre-LPI.

Measure the peak-to-peak voltage.

If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real
Edge.

If the Test Application is running on the UXR Oscilloscope, perform the measurement with the
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to
Channels 3 and 4.

Request DUT to be in LPI.
Measure the peak-to-peak voltage again.

If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real
Edge.

If the Test Application is running on the UXR Oscilloscope, perform the measurement with the
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to
Channels 3 and 4.

Calculate Vpp(post)-Vpp(pre).
Compare the result from step 8 to 150 mV.
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Exporting Measurement Results to Repository

Uploading Results to Repository

84

The Upload Results To Repository feature is an add-on to the Keysight Test Application, where it
expands the boundaries of storing and analyzing the measurement results to a wider audience, who
may be based in multiple sites across various geographical locations. Along with the feature of
exporting test results from the Test Application into your local disk in a CSV or HTML file format, you
have the option to upload the test results to a Dataset on a Web Repository. Based on your
requirements, you may either upload only a single measurement trial or upload huge volumes of
measurement results to any Dataset.

Not only can remote users with an active Internet connection access these Datasets and the
corresponding test results on the Web Repository, but they have the option to add and delete
Datasets on the Web Server. In the Upload Results To Repository feature, you can even modify the
Dataset properties, which are helpful especially when performing a graphical analysis of the
uploaded data.

In combination with the Keysight KS6800A Series Analytics Software, the Upload Results To
Repository feature provides a comprehensive solution to export, view and perform analysis of the
measurement results, thereby resulting in qualitative data to ensure that the Device Under Test
(DUT) is compliant to the industry standards.

Refer to the Keysight KS6800A Series Analytics Software Online Help for more information about the
functionality of various features in this software.

To export measurement results to the Repository after the completion of test runs,

1 From the Test Application’s main menu, click File > Export Results... > Repository.

File| View Tools Help
Connect to Infiniium... ct | Run | Automate | Results | HTML Report

New Project...

Open Project...

Save Project

Save Project As...

Save Project (Settings Only) As...

Export Results... 'ICSV

User Defined » HTML
Print... PDF

Print Preview... Repository k
Page Setup... ‘
Exit...
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Exporting Measurement Results to Repository 12

The Upload Results to Repository window appears.

2 In the Connect to Server pane of the Datasets tab, click Connect... to login to the Dataset Repository
server.

Upload Results To Repository

Datasets
Connect to Server

|Connect...

3 Inthe URL: drop-down text field that appears, replace the default text with the actual IP address
or the URL along with the port number, if applicable.
You may enter the URL of the Web Repository server, which may be a self-hosted server on your
machine (http://localhost:5000/), a remote server or an authentication server. Note that all such
URLs accessed via this window appear as a drop-down list in the URL: field.

4 Click the Check button to verify that the KS6800A Series Analytics service is available on the
specified web address. Repeat this step each time you edit the web address.

. Upload Results To Repository
Datasets
Connect to Server
.|URL: | https://address:port |E| |@|

—
| Browse... |
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Exporting Measurement Results to Repository

For unrestricted access to the Repository

a |Ifthe server does not require authentication and the KS6800A Series Analytics service is found
on the specified web address, the version information is displayed adjacent to the Check
button.

Upload Results To Repository

Datasets
Connect to Server
JURL: | http:// A - 5000/ |V | Check] version 2.0.31
| Browse... |
oK |
—_—
| cancel |

b If you click OK, the Upload Results to Repository window displays the connectivity status to
the Dataset Repository.

c Click Browse... to navigate directly to the URL.

Upload Results To Repository

Datasets

Connect to Server

Connected to http: // N - 5000/

[Connect...|

—
| Browse... |

For restricted access to the Repository

a If service is found on the specified URL but access to the web server is restricted based on
authentication, the version information is displayed along with the text Authentication
Required adjacent to the Check button. Also, the Username: and Password: fields appear. The
OK button remains disabled until the authentication credentials are entered.

b Enter the user credentials in the respective fields, which are required for authentication to
access those Datasets that have been created on the web server you are connecting to. For
each URL that you access, the Username: drop-down box keeps a record and displays all user
names used to access the respective URL.

Connect to Server

Upload Results To Repository

http:// I - 5000/ |E| (Check|Version 2.0.31, Authentication Required

[ Browse... | Username: |LPUser |E-|

Password:
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Exporting Measurement Results to Repository

¢ Click OK to connect to the entered URL/IP address.
The Connect to Server area displays the connection status along with the username.
d Click Browse... to navigate directly to the URL.

12

Upload Results To Repository

Datasets

Connect to Server
Logged in to: http:// I : 5000/ as LPUser
|

—
| Browse... |

| Logout |

5 In the Select Dataset area, click Select... to view the list of Datasets created on the connected

repository. Click Refresh to update the list of Datasets that appear in the Test Application's user

interface.
6 Select the Dataset name where you wish to upload measurement results to. Click OK.

Upload Results To Repository
Datasets

Connect to Server

Logged in to: http:// N 5000/ as LPUser

_
| Browse...
| Logout |

Select Dataset

Ci1

Ccig
CSV-Import-Testl
Example Measurements
eyes

Importll

jca

JSON Import Test1
LP1

NewDatasetl
Pareto

Pending Upload Summary

Keysight D90T0BJCC T00GBASE-CR4 Test Application Methods of Implementation

87



12 Exporting Measurement Results to Repository

The Select Dataset area displays the selected Dataset as Active. The Measurements and
Properties tabs are enabled after a Dataset is selected.

Upload Results To Repository
Datasets | Measurements | Properties

Connect to Server

Logged in to: http:ﬂ_:SDDlJ{ as LPUser
n |

—
| Browse... |

Logout |
Select Dataset
Active: Example Measurements
s
[Select...|

| Refresh |

Pending Upload Summary
(No meas its
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Exporting Measurement Results to Repository 12

7 Click the Measurements tab where the test results from the last test run are displayed.

8 You may select and export multiple test results to the repository. You may change the format for
the display of measurement data using the drop-down options in the Group by: field.

Upload Results To Repository
Datasets | Measurements | Properties

Group by: |Run Start Time| ¥ |
Select Run Start Times* to include:

B 2019-03-06 03:19:10:895|00:00:22.0210000

(Click on a Run Start Time to see measurements.)

«m >

*Each row contains results from a single execution of all checked tests; an N-Times or TestPlan execution

Pending Upload Summary

) measurements

9 After selecting one or more measurements, either click Upload or switch to the Properties tab to
associate one or more properties to the measurements that are being uploaded to the Web
Server.
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12 Exporting Measurement Results to Repository

To perform an enhanced analysis on the measurement data using the KS6800A Series Analytics
Service Software, Keysight recommends assigning properties to the measurements.

Upload Results To Repository

Datasets | Measurements | Properties
Select Properties to Include (Optional):
App-Defined

Show properties from: )

@ Globals (Settings from Set Up, Configure and HTML Report tabs)

[Auto... | Name|Value| Type|Reported With|Name In Repository
[Refresh|

User-Defined

[ Add... || |Name|value Type|Name In Repository

Pending Upload Summary

|Upload||Close]
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Exporting Measurement Results to Repository 12

10 Click the Properties tab to assign properties for your measurement results that you select to
upload. By default, the App-Defined properties are selected to be uploaded in association with the
measurement data, wherein only certain aspects of the selected measurements are uploaded.
However, you may switch to Globals to include as properties one or more options configured
under the rest of the tabs of the Compliance Test Application or define one or more custom
property values to be associated with the selected measurement data.

Upload Results To Repository

Datasets | Measurements | Properties

Select Properties to Include {(Optional):
App-Defined

Show properties from: @
© Globals (Settings from Set Up, Configure and HTML Report tat|
[Auto... | Name

[Refresh| [l |A Hidden

ype |Location Name In]

|Upload||Close]

11 Click Upload to begin uploading measurement results.
12 Click Close to exit the Upload Results to Repository window and to return to the Compliance Test
Application.

You may access the Dataset Repository using the Internet browser on your machine to view the
measurement results graphically on the KS6800A Series Analytics Service Software.
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12 Exporting Measurement Results to Repository

KSB800A Series Analytics Service Software

The KSB6800A Series Analytics Service software supports multiple data sources and also a wide range
of data import clients. This web-based software provides various types of charts, such as Histogram,
Box-and-Whisker, Line, Scatter, Eye Diagram and Constellation, each with split capability to enable
data analysis. Once you upload the measurement results to a Dataset on the KS6800A Series
Analytics Service Software via the Upload Results to Repository window of the Test Application, the
measurement results can be viewed graphically as shown below:

= O *
A x  +
&« C @ Notsecure | XxXXXXXXXX.cos.is.keysight.com:5000/datasets/Pareto/charts X #+ Bl 0o o
PATH Keysight KS6800A Series Analytics

~/  View Data All Da S reto > Chart
ADD PLOT

&€ Import Data [63.225,65.898] =

VIEW TABLE

FILTER

SELECTION

EXPLAIN

Failure

Days Until

CONFIGURE CHART

Ul Version: 1.0.37 Server Version: 2.2.3

For more information on the Data Analytics Web Service Software, visit KS6800A Series Analytics
Service Software page on the Keysight website. You may refer to the Help manual provided within
the software to understand the functionality of its features.
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13 Debug Mode

Debug mode can be selected to make enable the ability to change jitter measurement options. In the
Configuration tab, select the Debug radio button. This will add the following options:

KEYSIGHT

TECHNOLOGIES

Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). This changes the
amount of DC jitter in the R} measurement.

Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data patterns that are
periodic and repeat through the scope memory. Arbitrary is used for random data patterns or long
data patterns (for example, PRBS31) that do not repeat through the scope memory. If Arbitrary is
selected, set the IS| filters.

ISI Filter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the Leading ISI filter
coefficient. To help select the correct IS filter, see Application Note 1574: Choosing the ISI Filter
Size for EZJIT Plus Arbitrary Data Jitter Analysis (at www.keysight.com, literature part number
5989-4974EN).

ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the Lagging ISI filter
coefficient. Again, to help select the correct IS| filter, see Application Note 1574: Choosing the IS|
Filter Size for EZJIT Plus Arbitrary Data Jitter Analysis.


http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf

13 Debug Mode
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DC Common Mode Output Voltage Test, 42
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ISI Filter Lead, 93

J

jitter, 48
jitter and data rate measurements, 45
Jitter Pattern Length, 93

L
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Linear Fit Pulse Peak, 52,53

M

main voltage measurements, 39
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56, 64, 68

measurements, preparing, 17

Minimum Post-cursor Full-scale Test, 66

Minimum Pre-cursor Full-scale Test, 65

mouse, 9
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random jitter, 48

Results tab, 22
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Rj Bandwidth, 93
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Set Up tab, 21
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